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WANNIER90 code directly called from SIESTA

WANNIER90 code (version 3.0.0) has been compiled in 
library mode and called directly from SIESTA

That means that we can run all the functionalities of 
WANNIER90 directly from SIESTA

Advantages

• No need to prepare two different input files
• No need to run WANNIER90 in pre-processing mode
• We can use the basis set of SIESTA (numerical atomic orbitals) as the initial

guess for the projections
• Wannierization of different manifolds can be done in the same run of SIESTA
• The unitary matrices connecting the Bloch and Wannier representations are 

available in SIESTA.  
New functionalities can follow (initial guesses for order-N simulations)

• Interface with other codes will be much easier:
SCALE-UP (second-principles)
DMFTWDFT (DMFT code by Aldo Romero’s group)



WANNIER90 code directly called from SIESTA

Practical examples:
Bulk SrTiO3 in the cubic phase

Graphene 



After running SIESTA and compute the PDOS,           
we can analyze the character of the different bands
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Which atoms contribute more to the bands at a particular energy window



We can analyze the character of the different bands
Which atoms contribute more to the bands at a particular energy window

Zoom around the top of the valence bands and bottom of conduction bands
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Top of valence bands: 
mostly O 2p character

Bottom of conduction bands: 
mostly Ti t2g character

We can project on 
particular atomic 
orbitals within an 
atom to further 

define the 
character.



Choose the Bloch states that will be used to 
compute the Wannier functions 

In this particular example, we are interested in the wannierization of 
three different manifolds 

Manifold number 1:

That means:
- 3 O p bands (px, py, pz) 
 × 3 O atoms

9 bands to wannierize

Top of valence bands: 
mostly O 2p character
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Choose the Bloch states that will be used to 
compute the Wannier functions 
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In this particular example, we are interested in the wannierization of 
three different manifolds 

Manifold number 2:

That means:
-3 Ti t2g bands (dxy, dyz, dxz)

3 bands to wannierize

Bottom of conduction bands: 
mostly Ti t2g character



Choose the Bloch states that will be used to 
compute the Wannier functions 
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In this particular example, we are interested in the wannierization of 
three different manifolds 

Manifold number 3:

Bottom of conduction bands: 
mostly Ti t2g character

Top of valence bands: 
mostly O 2p character

That means:
- 3 O p bands (px, py, pz) 
 × 3 O atoms
- 3 Ti t2g bands (dxy, dyz, dxz)

12 bands to wannierize



SIESTA variables related with the wannierization

Number of manifolds to wannierize

4

%block WannierManifolds
first
second
third

%endblock

%block WannierManifold.first
# Indices of the initial and final band of the manifold
bands 12 20
# Indices of the orbitals that will be used as localized trial orbitals
# (any number of lines allowed)
trial-orbitals [36 37 38]
trial-orbitals [49 50 51]
trial-orbitals [62 63 64]
# Number of iterations for the minimization of \Omega
spreading.nitt 0
wannier_plot 3
fermi_surface_plot true
write_hr true
write_tb true

%endblock

As many lines in the block as 
manifolds will be wannierized

A nickname is given to each manifold



SIESTA variables related with the wannierization

Information for every manifold
4

%block WannierManifolds
first
second
third

%endblock

%block WannierManifold.first
# Indices of the initial and final band of the manifold
bands 12 20
# Indices of the orbitals that will be used as localized trial orbitals
# (any number of lines allowed)
trial-orbitals [36 37 38]
trial-orbitals [49 50 51]
trial-orbitals [62 63 64]
# Number of iterations for the minimization of \Omega
spreading.nitt 0
wannier_plot 3
fermi_surface_plot true
write_hr true
write_tb true

%endblock

The nickname of every manifold is appended here to 
the keyword WannierManifold

As many WannierManifolds blocks as manifolds considered for wannierization



SIESTA variables related with the wannierization

4

%block WannierManifolds
first
second
third

%endblock

%block WannierManifold.first
# Indices of the initial and final band of the manifold
bands 12 20
# Indices of the orbitals that will be used as localized trial orbitals
# (any number of lines allowed)
trial-orbitals [36 37 38]
trial-orbitals [49 50 51]
trial-orbitals [62 63 64]
# Number of iterations for the minimization of \Omega
spreading.nitt 0
wannier_plot 3
fermi_surface_plot true
write_hr true
write_tb true

%endblock

3

!
! For every k-point, the bands in Siesta are ordered from lowest to highest
! energy
! The character of the bands are known after computation of the PDOS.
! In order, for the case of SrTiO3:
! -----------------------------------------------------------------------
! Bands to be excluded
! -----------------------------------------------------------------------
! Band 1 (lowest band): Ti-3s character
! Bands 2, 3, and 4: Ti-3p character (px, py, and pz)
! Band 5: Sr-4s character
! Bands 6, 7, and 8: O-2s character (1 band * 3 O atoms in the unit cell)
! Bands 9, 10, and 11: Sr-4p character (px, py, and pz)
! -----------------------------------------------------------------------
! Bands to be wannierized
! -----------------------------------------------------------------------
! Bands 12-20: O-2p character (3 bands * 3 O atoms in the unit cell)
! Bands 21, 22, and 23: Ti-t2g characer (dxy, dyz, dxz)

--- reference section
PSML-related libs: /Users/javier/lib/Gfortran/lib/libpsml.a
XMLf90 libs: /Users/javier/lib/Gfortran/lib/libxmlf90.a
GRIDXC libs: /Users/javier/lib/Gfortran/lib/libGridXC.a -L/Users/javier/lib/Gfortran/lib -l xcf90 -l xc
--- end of reference section

Reading KB projs from Si psml data

PSML: Kleinman-Bylander projectors:
l= 0 rc= 1.936440 Ekb= 4.661340
l= 1 rc= 1.936440 Ekb= 1.494238
l= 2 rc= 1.936440 Ekb= -2.809035
l= 3 rc= 1.936440 Ekb= -0.959387

$ ../configure --with-config-file=psml.ac
$ make -j4
$ make install
$ cd tests
$ ../../tests/runtests.py -j4 psml

#
# --- Edit the location of your psml files
#
ROOT_GLOBAL=$(HOME)/lib/Gfortran
PSML_ROOT=$(ROOT_GLOBAL)
XMLF90_ROOT=$(ROOT_GLOBAL)
GRIDXC_ROOT=$(ROOT_GLOBAL)
LIBXC_ROOT=$(ROOT_GLOBAL)

--- reference section
PSML-related libs: /Users/javier/lib/Gfortran/lib/libpsml.a
XMLf90 libs: /Users/javier/lib/Gfortran/lib/libxmlf90.a
GRIDXC libs: /Users/javier/lib/Gfortran/serial/lib/libGridXC.a -L/Users/javier/lib/Gfortran/lib -l xcf90 -l xc
--- end of reference section



SIESTA variables related with the wannierization

4

%block WannierManifolds
first
second
third

%endblock

%block WannierManifold.first
# Indices of the initial and final band of the manifold
bands 12 20
# Indices of the orbitals that will be used as localized trial orbitals
# (any number of lines allowed)
trial-orbitals [36 37 38]
trial-orbitals [49 50 51]
trial-orbitals [62 63 64]
# Number of iterations for the minimization of \Omega
spreading.nitt 0
wannier_plot 3
fermi_surface_plot true
write_hr true
write_tb true

%endblock



SIESTA variables related with the wannierization
4

72 9000 = orbitals in unit cell and supercell. See end of file.

io ia is spec iao n l m z p sym rc isc iuo
1 1 1 Sr 1 4 0 0 1 F s 6.602 0 0 0 1
2 1 1 Sr 2 5 0 0 1 F s 7.116 0 0 0 2
3 1 1 Sr 3 5 0 0 2 F s 5.542 0 0 0 3
4 1 1 Sr 4 4 1 -1 1 F py 6.769 0 0 0 4
5 1 1 Sr 5 4 1 0 1 F pz 6.769 0 0 0 5
6 1 1 Sr 6 4 1 1 1 F px 6.769 0 0 0 6
7 1 1 Sr 7 5 1 -1 1 F py 4.004 0 0 0 7
8 1 1 Sr 8 5 1 0 1 F pz 4.004 0 0 0 8
9 1 1 Sr 9 5 1 1 1 F px 4.004 0 0 0 9

10 1 1 Sr 10 4 2 -2 1 F dxy 6.602 0 0 0 10
11 1 1 Sr 11 4 2 -1 1 F dyz 6.602 0 0 0 11
12 1 1 Sr 12 4 2 0 1 F dz2 6.602 0 0 0 12
13 1 1 Sr 13 4 2 1 1 F dxz 6.602 0 0 0 13
14 1 1 Sr 14 4 2 2 1 F dx2-y2 6.602 0 0 0 14
15 2 2 Ti 1 3 0 0 1 F s 5.806 0 0 0 15
16 2 2 Ti 2 4 0 0 1 F s 6.104 0 0 0 16
17 2 2 Ti 3 4 0 0 2 F s 5.124 0 0 0 17
18 2 2 Ti 4 3 1 -1 1 F py 5.806 0 0 0 18
19 2 2 Ti 5 3 1 0 1 F pz 5.806 0 0 0 19
20 2 2 Ti 6 3 1 1 1 F px 5.806 0 0 0 20
21 2 2 Ti 7 4 1 -1 1 F py 3.108 0 0 0 21
22 2 2 Ti 8 4 1 0 1 F pz 3.108 0 0 0 22
23 2 2 Ti 9 4 1 1 1 F px 3.108 0 0 0 23
24 2 2 Ti 10 3 2 -2 1 F dxy 5.953 0 0 0 24
25 2 2 Ti 11 3 2 -1 1 F dyz 5.953 0 0 0 25
26 2 2 Ti 12 3 2 0 1 F dz2 5.953 0 0 0 26
27 2 2 Ti 13 3 2 1 1 F dxz 5.953 0 0 0 27
28 2 2 Ti 14 3 2 2 1 F dx2-y2 5.953 0 0 0 28
29 2 2 Ti 15 3 2 -2 2 F dxy 4.754 0 0 0 29
30 2 2 Ti 16 3 2 -1 2 F dyz 4.754 0 0 0 30
31 2 2 Ti 17 3 2 0 2 F dz2 4.754 0 0 0 31
32 2 2 Ti 18 3 2 1 2 F dxz 4.754 0 0 0 32
33 2 2 Ti 19 3 2 2 2 F dx2-y2 4.754 0 0 0 33
34 3 3 O 1 2 0 0 1 F s 4.931 0 0 0 34
35 3 3 O 2 2 0 0 2 F s 3.653 0 0 0 35
36 3 3 O 3 2 1 -1 1 F py 5.056 0 0 0 36
37 3 3 O 4 2 1 0 1 F pz 5.056 0 0 0 37
38 3 3 O 5 2 1 1 1 F px 5.056 0 0 0 38
39 3 3 O 6 2 1 -1 2 F py 3.937 0 0 0 39
40 3 3 O 7 2 1 0 2 F pz 3.937 0 0 0 40
41 3 3 O 8 2 1 1 2 F px 3.937 0 0 0 41
42 3 3 O 9 3 2 -2 1 F dxy 2.774 0 0 0 42
43 3 3 O 10 3 2 -1 1 F dyz 2.774 0 0 0 43
44 3 3 O 11 3 2 0 1 F dz2 2.774 0 0 0 44
45 3 3 O 12 3 2 1 1 F dxz 2.774 0 0 0 45
46 3 3 O 13 3 2 2 1 F dx2-y2 2.774 0 0 0 46
47 4 3 O 1 2 0 0 1 F s 4.931 0 0 0 47
48 4 3 O 2 2 0 0 2 F s 3.653 0 0 0 48
49 4 3 O 3 2 1 -1 1 F py 5.056 0 0 0 49
50 4 3 O 4 2 1 0 1 F pz 5.056 0 0 0 50
51 4 3 O 5 2 1 1 1 F px 5.056 0 0 0 51
52 4 3 O 6 2 1 -1 2 F py 3.937 0 0 0 52
53 4 3 O 7 2 1 0 2 F pz 3.937 0 0 0 53
54 4 3 O 8 2 1 1 2 F px 3.937 0 0 0 54
55 4 3 O 9 3 2 -2 1 F dxy 2.774 0 0 0 55

5

56 4 3 O 10 3 2 -1 1 F dyz 2.774 0 0 0 56
57 4 3 O 11 3 2 0 1 F dz2 2.774 0 0 0 57
58 4 3 O 12 3 2 1 1 F dxz 2.774 0 0 0 58
59 4 3 O 13 3 2 2 1 F dx2-y2 2.774 0 0 0 59
60 5 3 O 1 2 0 0 1 F s 4.931 0 0 0 60
61 5 3 O 2 2 0 0 2 F s 3.653 0 0 0 61
62 5 3 O 3 2 1 -1 1 F py 5.056 0 0 0 62
63 5 3 O 4 2 1 0 1 F pz 5.056 0 0 0 63
64 5 3 O 5 2 1 1 1 F px 5.056 0 0 0 64
65 5 3 O 6 2 1 -1 2 F py 3.937 0 0 0 65
66 5 3 O 7 2 1 0 2 F pz 3.937 0 0 0 66
67 5 3 O 8 2 1 1 2 F px 3.937 0 0 0 67
68 5 3 O 9 3 2 -2 1 F dxy 2.774 0 0 0 68
69 5 3 O 10 3 2 -1 1 F dyz 2.774 0 0 0 69
70 5 3 O 11 3 2 0 1 F dz2 2.774 0 0 0 70
71 5 3 O 12 3 2 1 1 F dxz 2.774 0 0 0 71
72 5 3 O 13 3 2 2 1 F dx2-y2 2.774 0 0 0 72

Take a look to the SystemLabel.ORB_INDX file

p-orbitals of the first O atom

p-orbitals of the second O atom

p-orbitals of the third O atom

A good initial guess to project the bands of the top 
of the valence band are the O-2p orbitals



SIESTA variables related with the wannierization

4

%block WannierManifolds
first
second
third

%endblock

%block WannierManifold.first
# Indices of the initial and final band of the manifold
bands 12 20
# Indices of the orbitals that will be used as localized trial orbitals
# (any number of lines allowed)
trial-orbitals [36 37 38]
trial-orbitals [49 50 51]
trial-orbitals [62 63 64]
# Number of iterations for the minimization of \Omega
spreading.nitt 0
wannier_plot 3
fermi_surface_plot true
write_hr true
write_tb true

%endblock

Number of iterations for the minimization of the localization functional

If zero, then the procedure is the same as a Löwdin orthonormalization

The resulting Wannier functions will keep the symmetry of the 
projection function, but it will not be maximally localized



SIESTA variables related with the wannierization

4

%block WannierManifolds
first
second
third

%endblock

%block WannierManifold.first
# Indices of the initial and final band of the manifold
bands 12 20
# Indices of the orbitals that will be used as localized trial orbitals
# (any number of lines allowed)
trial-orbitals [36 37 38]
trial-orbitals [49 50 51]
trial-orbitals [62 63 64]
# Number of iterations for the minimization of \Omega
spreading.nitt 0
wannier_plot 3
fermi_surface_plot true
write_hr true
write_tb true

%endblock

Instruction to plot the Wannier functions

The integer refers to the size of the supercell for plotting the Wannier functions



SIESTA variables related with the wannierization

4

%block WannierManifolds
first
second
third

%endblock

%block WannierManifold.first
# Indices of the initial and final band of the manifold
bands 12 20
# Indices of the orbitals that will be used as localized trial orbitals
# (any number of lines allowed)
trial-orbitals [36 37 38]
trial-orbitals [49 50 51]
trial-orbitals [62 63 64]
# Number of iterations for the minimization of \Omega
spreading.nitt 0
wannier_plot 3
fermi_surface_plot true
write_hr true
write_tb true

%endblock

Flag to determine whether the Fermi Surface is computed or not



SIESTA variables related with the wannierization

4

%block WannierManifolds
first
second
third

%endblock

%block WannierManifold.first
# Indices of the initial and final band of the manifold
bands 12 20
# Indices of the orbitals that will be used as localized trial orbitals
# (any number of lines allowed)
trial-orbitals [36 37 38]
trial-orbitals [49 50 51]
trial-orbitals [62 63 64]
# Number of iterations for the minimization of \Omega
spreading.nitt 0
wannier_plot 3
fermi_surface_plot true
write_hr true
write_tb true

%endblock

Flag to determine whether the Hamiltonian in real space in a basis of Wannier
functions is written

SystemLabel.manifold.X_hr.dat

X is the nickname of the manifold



SIESTA variables related with the wannierization

4

%block WannierManifolds
first
second
third

%endblock

%block WannierManifold.first
# Indices of the initial and final band of the manifold
bands 12 20
# Indices of the orbitals that will be used as localized trial orbitals
# (any number of lines allowed)
trial-orbitals [36 37 38]
trial-orbitals [49 50 51]
trial-orbitals [62 63 64]
# Number of iterations for the minimization of \Omega
spreading.nitt 0
wannier_plot 3
fermi_surface_plot true
write_hr true
write_tb true

%endblock

Flag to determine whether the lattice vectors, Hamiltonian in real space and 
position operator in a basis of Wannier functions are written

SystemLabel.manifold.X_tb.dat

X is the nickname of the manifold



SIESTA variables related with the wannierization

Number of k-points used in the Wannierization

4

%block WannierManifolds
first
second
third

%endblock

%block WannierManifold.first
# Indices of the initial and final band of the manifold
bands 12 20
# Indices of the orbitals that will be used as localized trial orbitals
# (any number of lines allowed)
trial-orbitals [36 37 38]
trial-orbitals [49 50 51]
trial-orbitals [62 63 64]
# Number of iterations for the minimization of \Omega
spreading.nitt 0
wannier_plot 3
fermi_surface_plot true
write_hr true
write_tb true

%endblock

Wannier.k [4 4 4]

switch_local_projection: Populating the relevant matrices for
switch_local_projection: calling WANNIER90 directly from SIESTA
switch_local_projection: band manifold = first

compute_pw_matrix: Computing the matrix elements of a plane wave

mmn: Overlap matrices between periodic part of wavefunctions
mmn: written in w90_in_siesta.manifold.first.mmn file

amn: Overlap matrices between trial projection functions and wavefunctions
amn: written in w90_in_siesta.manifold.first.amn file

eig: Eigenvalues of the Hamiltonian
eig: written in w90_in_siesta.manifold.first.eigW file

compute_matrices: All the information dumped in the corresponding files
compute_matrices: End of the interface between Siesta and Wannier90
... Calling wannier90 for this manifold
... See file w90_in_siesta.manifold.first.wout for information



Succesful output of SIESTA

4

%block WannierManifolds
first
second
third

%endblock

%block WannierManifold.first
# Indices of the initial and final band of the manifold
bands 12 20
# Indices of the orbitals that will be used as localized trial orbitals
# (any number of lines allowed)
trial-orbitals [36 37 38]
trial-orbitals [49 50 51]
trial-orbitals [62 63 64]
# Number of iterations for the minimization of \Omega
spreading.nitt 0
wannier_plot 3
fermi_surface_plot true
write_hr true
write_tb true

%endblock

switch_local_projection: Populating the relevant matrices for
switch_local_projection: calling WANNIER90 directly from SIESTA
switch_local_projection: band manifold = first

compute_pw_matrix: Computing the matrix elements of a plane wave

mmn: Overlap matrices between periodic part of wavefunctions
mmn: written in w90_in_siesta.manifold.first.mmn file

amn: Overlap matrices between trial projection functions and wavefunctions
amn: written in w90_in_siesta.manifold.first.amn file

eig: Eigenvalues of the Hamiltonian
eig: written in w90_in_siesta.manifold.first.eigW file

compute_matrices: All the information dumped in the corresponding files
compute_matrices: End of the interface between Siesta and Wannier90
... Calling wannier90 for this manifold
... See file w90_in_siesta.manifold.first.wout for information



5

*------------------------------- WANNIERISE ---------------------------------*
+--------------------------------------------------------------------+<-- CONV
| Iter Delta Spread RMS Gradient Spread (Ang^2) Time |<-- CONV
+--------------------------------------------------------------------+<-- CONV

------------------------------------------------------------------------------
Initial State
WF centre and spread 1 ( -0.000000, 1.937000, 1.937000 ) 1.28449725
WF centre and spread 2 ( -0.000000, 1.937000, 1.937000 ) 1.28449725
WF centre and spread 3 ( 0.000000, 1.937000, 1.937000 ) 1.17470279
WF centre and spread 4 ( 1.937000, -0.000000, 1.937000 ) 1.17470279
WF centre and spread 5 ( 1.937000, 0.000000, 1.937000 ) 1.28449725
WF centre and spread 6 ( 1.937000, -0.000000, 1.937000 ) 1.28449725
WF centre and spread 7 ( 1.937000, 1.937000, 0.000000 ) 1.28449726
WF centre and spread 8 ( 1.937000, 1.937000, 0.000000 ) 1.17470278
WF centre and spread 9 ( 1.937000, 1.937000, 0.000000 ) 1.28449726
Sum of centres and spreads ( 11.622000, 11.622000, 11.622000 ) 11.23109189

0 0.112E+02 0.0000000000 11.2310918853 0.00 <-- CONV
O_D= 0.0000000 O_OD= 0.1485757 O_TOT= 11.2310919 <-- SPRD

------------------------------------------------------------------------------
Final State
WF centre and spread 1 ( -0.000000, 1.937000, 1.937000 ) 1.28449725
WF centre and spread 2 ( -0.000000, 1.937000, 1.937000 ) 1.28449725
WF centre and spread 3 ( 0.000000, 1.937000, 1.937000 ) 1.17470279
WF centre and spread 4 ( 1.937000, -0.000000, 1.937000 ) 1.17470279
WF centre and spread 5 ( 1.937000, 0.000000, 1.937000 ) 1.28449725
WF centre and spread 6 ( 1.937000, -0.000000, 1.937000 ) 1.28449725
WF centre and spread 7 ( 1.937000, 1.937000, 0.000000 ) 1.28449726
WF centre and spread 8 ( 1.937000, 1.937000, 0.000000 ) 1.17470278
WF centre and spread 9 ( 1.937000, 1.937000, 0.000000 ) 1.28449726
Sum of centres and spreads ( 11.622000, 11.622000, 11.622000 ) 11.23109189

Spreads (Ang^2) Omega I = 11.082516189
================ Omega D = 0.000000000

Omega OD = 0.148575697
Final Spread (Ang^2) Omega Total = 11.231091885

------------------------------------------------------------------------------
Time for wannierise 0.002 (sec)

Succesful output of SIESTA
The output is exactly the

same as the WANNIER90 code

9 WF centered on the three O
The spread of the Wannier 

functions (in Å) is three and six 
fold degenerated 



How to plot the Wannier functions

seedname.fdf file
(input of SIESTA)

First of all, SIESTA has to write the periodic part of the Bloch functions in a 3D grid. 
The number of points in the grid along the three lattice vectors are given by 

This produces many files with the name UNKXXXXX.Y where
• XXXXX is the number of the k-point, from 1 to the number of 

points included in seedname.win file 
• Y refers to the spin compoment (1 or 2)

5

*------------------------------- WANNIERISE ---------------------------------*
+--------------------------------------------------------------------+<-- CONV
| Iter Delta Spread RMS Gradient Spread (Ang^2) Time |<-- CONV
+--------------------------------------------------------------------+<-- CONV

------------------------------------------------------------------------------
Initial State
WF centre and spread 1 ( -0.000000, 1.937000, 1.937000 ) 1.28449725
WF centre and spread 2 ( -0.000000, 1.937000, 1.937000 ) 1.28449725
WF centre and spread 3 ( 0.000000, 1.937000, 1.937000 ) 1.17470279
WF centre and spread 4 ( 1.937000, -0.000000, 1.937000 ) 1.17470279
WF centre and spread 5 ( 1.937000, 0.000000, 1.937000 ) 1.28449725
WF centre and spread 6 ( 1.937000, -0.000000, 1.937000 ) 1.28449725
WF centre and spread 7 ( 1.937000, 1.937000, 0.000000 ) 1.28449726
WF centre and spread 8 ( 1.937000, 1.937000, 0.000000 ) 1.17470278
WF centre and spread 9 ( 1.937000, 1.937000, 0.000000 ) 1.28449726
Sum of centres and spreads ( 11.622000, 11.622000, 11.622000 ) 11.23109189

0 0.112E+02 0.0000000000 11.2310918853 0.00 <-- CONV
O_D= 0.0000000 O_OD= 0.1485757 O_TOT= 11.2310919 <-- SPRD

------------------------------------------------------------------------------
Final State
WF centre and spread 1 ( -0.000000, 1.937000, 1.937000 ) 1.28449725
WF centre and spread 2 ( -0.000000, 1.937000, 1.937000 ) 1.28449725
WF centre and spread 3 ( 0.000000, 1.937000, 1.937000 ) 1.17470279
WF centre and spread 4 ( 1.937000, -0.000000, 1.937000 ) 1.17470279
WF centre and spread 5 ( 1.937000, 0.000000, 1.937000 ) 1.28449725
WF centre and spread 6 ( 1.937000, -0.000000, 1.937000 ) 1.28449725
WF centre and spread 7 ( 1.937000, 1.937000, 0.000000 ) 1.28449726
WF centre and spread 8 ( 1.937000, 1.937000, 0.000000 ) 1.17470278
WF centre and spread 9 ( 1.937000, 1.937000, 0.000000 ) 1.28449726
Sum of centres and spreads ( 11.622000, 11.622000, 11.622000 ) 11.23109189

Spreads (Ang^2) Omega I = 11.082516189
================ Omega D = 0.000000000

Omega OD = 0.148575697
Final Spread (Ang^2) Omega Total = 11.231091885

------------------------------------------------------------------------------
Time for wannierise 0.002 (sec)

Wannier.Manifolds.Unk .true.

Siesta2Wannier90.UnkGrid1 30
Siesta2Wannier90.UnkGrid2 30
Siesta2Wannier90.UnkGrid3 30



How to plot the Wannier functions
WANNIER90 produces files with the name:

SystemLabel.manifold.X_0000Y.xsf that can be directly plotted with XCRYSDEN  

Once XCrySDen starts, click on 
File → Open structure (Select your xsf file)

Tools → Data Grid 

Click on OK
Then, select: 

Degree of triCubic Spline: 3
Click on Render+/- isovalue

Select the desired isovalue (in this example 0.1)
Submit

SrTiO3.manifold.first_00001.xsf



WANNIER90 code directly called from SIESTA

Practical examples:
Bulk SrTiO3 in the cubic phase

Graphene 



2

SystemName graphene
# Graphene layer
# Ghost atoms included at the center of the bonds
# MeshCutoff: 600 Ry
# 20 x 20 x 1 Monkhorst-Pack mesh

SystemLabel graphene

NumberOfAtoms 5 # Number of atoms in the unit cell
# We include here:
# - The two carbon atoms of the motif
# - Three Hydrogen ghost atoms at the center
# of the bonds between first-neighbors
# Only the atomic orbitals of the atoms
# will be included in the simulation,
# while the atomic nuclei will not be
# considered

NumberOfSpecies 2 # Number of different atomic species in the
# simulation.
# We include here:
# - C (with an atomic number of 6)
# - pseudo-Hydrogen atom
# (with an atomic number of -1)

%block ChemicalSpeciesLabel # Chemical species label as indicated above
1 6 C
2 -1 Ghost-H

%endblock ChemicalSpeciesLabel

Graphene,                                                          
including bond centered Hydrogen ghost atoms 



Graphene: atomic structure in SIESTA
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#
# Atomic structure: lattice vectors and atomic coordinates
#

LatticeConstant 1.46700 Ang # Nearest-neighbor distance, d
# The primitive translation vectors
# will be given by
# a_{1} = (3/2 d, - sqrt(3)/2 d, 0)
# a_{2} = (3/2 d, + sqrt(3)/2 d, 0)
# Here the z-component of the vectors
# is large enough to avoid interactions
# between periodic replicas of the slab

%block LatticeVectors
1.500000000 -0.8660254038 0.0000000000
1.500000000 0.8660254038 0.0000000000
0.000000000 0.0000000000 20.0000000000

%endblock LatticeVectors

AtomicCoordinatesFormat Fractional
%block AtomicCoordinatesAndAtomicSpecies

0.3333333333 0.3333333333 0.0000000000 1
0.6666666667 0.6666666667 0.0000000000 1
0.5000000000 0.5000000000 0.0000000000 2
0.5000000000 0.0000000000 0.0000000000 2
0.0000000000 0.5000000000 0.0000000000 2

%endblock AtomicCoordinatesAndAtomicSpecies

%block kgrid_Monkhorst_Pack
20 0 0 0.0
0 20 0 0.0
0 0 1 0.0

%endblock Kgrid_Monkhorst_Pack



Graphene: plotting the band-structure in SIESTA
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#
# Plotting the band structure
#

BandLinesScale ReciprocalLatticeVectors
%block BandLines
1 0.0 0.0 0.0 \Gamma # Begin at \Gamma
50 0.33333 0.666667 0.0 K # 50 points from \Gamma to K
50 0.5 0.5 0.0 M # 50 points from K to M
50 0.0 0.0 0.0 \Gamma # 50 points from M to \Gamma
%endblock BandLines

#
# Plotting the Projected Density Of States
#

%block ProjectedDensityOfStates
-70.00 5.00 0.150 3000 eV

%endblock ProjectedDensityOfStates

%PDOS.kgrid_Monkhorst_Pack
60 0 0 0.5
0 60 0 0.5
0 0 2 0.5

%end PDOS.kgrid_Monkhorst_Pack
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*------------------------------- WANNIERISE ---------------------------------*
+--------------------------------------------------------------------+<-- CONV
| Iter Delta Spread RMS Gradient Spread (Ang^2) Time |<-- CONV
+--------------------------------------------------------------------+<-- CONV

------------------------------------------------------------------------------
Initial State
WF centre and spread 1 ( -0.000000, 1.937000, 1.937000 ) 1.28449725
WF centre and spread 2 ( -0.000000, 1.937000, 1.937000 ) 1.28449725
WF centre and spread 3 ( 0.000000, 1.937000, 1.937000 ) 1.17470279
WF centre and spread 4 ( 1.937000, -0.000000, 1.937000 ) 1.17470279
WF centre and spread 5 ( 1.937000, 0.000000, 1.937000 ) 1.28449725
WF centre and spread 6 ( 1.937000, -0.000000, 1.937000 ) 1.28449725
WF centre and spread 7 ( 1.937000, 1.937000, 0.000000 ) 1.28449726
WF centre and spread 8 ( 1.937000, 1.937000, 0.000000 ) 1.17470278
WF centre and spread 9 ( 1.937000, 1.937000, 0.000000 ) 1.28449726
Sum of centres and spreads ( 11.622000, 11.622000, 11.622000 ) 11.23109189

0 0.112E+02 0.0000000000 11.2310918853 0.00 <-- CONV
O_D= 0.0000000 O_OD= 0.1485757 O_TOT= 11.2310919 <-- SPRD

------------------------------------------------------------------------------
Final State
WF centre and spread 1 ( -0.000000, 1.937000, 1.937000 ) 1.28449725
WF centre and spread 2 ( -0.000000, 1.937000, 1.937000 ) 1.28449725
WF centre and spread 3 ( 0.000000, 1.937000, 1.937000 ) 1.17470279
WF centre and spread 4 ( 1.937000, -0.000000, 1.937000 ) 1.17470279
WF centre and spread 5 ( 1.937000, 0.000000, 1.937000 ) 1.28449725
WF centre and spread 6 ( 1.937000, -0.000000, 1.937000 ) 1.28449725
WF centre and spread 7 ( 1.937000, 1.937000, 0.000000 ) 1.28449726
WF centre and spread 8 ( 1.937000, 1.937000, 0.000000 ) 1.17470278
WF centre and spread 9 ( 1.937000, 1.937000, 0.000000 ) 1.28449726
Sum of centres and spreads ( 11.622000, 11.622000, 11.622000 ) 11.23109189

Spreads (Ang^2) Omega I = 11.082516189
================ Omega D = 0.000000000

Omega OD = 0.148575697
Final Spread (Ang^2) Omega Total = 11.231091885

------------------------------------------------------------------------------
Time for wannierise 0.002 (sec)

%block WannierManifold.first
# Indices of the initial and final band of the manifold
bands 1 8
# Indices of the orbitals that will be used as localized trial orbitals
# (any number of lines allowed)
trial-orbitals [9 10 11 3 7]
# Number of iterations for the minimization of \Omega
spreading.nitt 0
wannier_plot 3
fermi_surface_plot true
write_hr true
write_tb true
# Bottom and top of the outer energy window for band disentanglement (in eV)
window -30.0 5.0 eV
# Bottom and top of the inner energy window for band disentanglement (in eV)
window.frozen -30.0 -7.5 eV

%endblock

WANNIER90 code directly available from SIESTA
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wannierization over the three sp2 orbitals
and the manifold

(five Wannier functions in total)

We have eight bands in the outer
energy window



5

*------------------------------- WANNIERISE ---------------------------------*
+--------------------------------------------------------------------+<-- CONV
| Iter Delta Spread RMS Gradient Spread (Ang^2) Time |<-- CONV
+--------------------------------------------------------------------+<-- CONV

------------------------------------------------------------------------------
Initial State
WF centre and spread 1 ( -0.000000, 1.937000, 1.937000 ) 1.28449725
WF centre and spread 2 ( -0.000000, 1.937000, 1.937000 ) 1.28449725
WF centre and spread 3 ( 0.000000, 1.937000, 1.937000 ) 1.17470279
WF centre and spread 4 ( 1.937000, -0.000000, 1.937000 ) 1.17470279
WF centre and spread 5 ( 1.937000, 0.000000, 1.937000 ) 1.28449725
WF centre and spread 6 ( 1.937000, -0.000000, 1.937000 ) 1.28449725
WF centre and spread 7 ( 1.937000, 1.937000, 0.000000 ) 1.28449726
WF centre and spread 8 ( 1.937000, 1.937000, 0.000000 ) 1.17470278
WF centre and spread 9 ( 1.937000, 1.937000, 0.000000 ) 1.28449726
Sum of centres and spreads ( 11.622000, 11.622000, 11.622000 ) 11.23109189

0 0.112E+02 0.0000000000 11.2310918853 0.00 <-- CONV
O_D= 0.0000000 O_OD= 0.1485757 O_TOT= 11.2310919 <-- SPRD

------------------------------------------------------------------------------
Final State
WF centre and spread 1 ( -0.000000, 1.937000, 1.937000 ) 1.28449725
WF centre and spread 2 ( -0.000000, 1.937000, 1.937000 ) 1.28449725
WF centre and spread 3 ( 0.000000, 1.937000, 1.937000 ) 1.17470279
WF centre and spread 4 ( 1.937000, -0.000000, 1.937000 ) 1.17470279
WF centre and spread 5 ( 1.937000, 0.000000, 1.937000 ) 1.28449725
WF centre and spread 6 ( 1.937000, -0.000000, 1.937000 ) 1.28449725
WF centre and spread 7 ( 1.937000, 1.937000, 0.000000 ) 1.28449726
WF centre and spread 8 ( 1.937000, 1.937000, 0.000000 ) 1.17470278
WF centre and spread 9 ( 1.937000, 1.937000, 0.000000 ) 1.28449726
Sum of centres and spreads ( 11.622000, 11.622000, 11.622000 ) 11.23109189

Spreads (Ang^2) Omega I = 11.082516189
================ Omega D = 0.000000000

Omega OD = 0.148575697
Final Spread (Ang^2) Omega Total = 11.231091885

------------------------------------------------------------------------------
Time for wannierise 0.002 (sec)

%block WannierManifold.first
# Indices of the initial and final band of the manifold
bands 1 8
# Indices of the orbitals that will be used as localized trial orbitals
# (any number of lines allowed)
trial-orbitals [9 10 11 3 7]
# Number of iterations for the minimization of \Omega
spreading.nitt 0
wannier_plot 3
fermi_surface_plot true
write_hr true
write_tb true
# Bottom and top of the outer energy window for band disentanglement (in eV)
window -30.0 5.0 eV
# Bottom and top of the inner energy window for band disentanglement (in eV)
window.frozen -30.0 -7.5 eV

%endblock

WANNIER90 code directly available from SIESTA
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Some Bloch states are forced to be 
preserved identically in the projected

manifold; those are referred to as 
belonging to a frozen “inner” window

Frozen
energy
window

We are interested in project over the
wannierization over the three sp2 orbitals

and the manifold (five Wannier
functions in total)
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*------------------------------- WANNIERISE ---------------------------------*
+--------------------------------------------------------------------+<-- CONV
| Iter Delta Spread RMS Gradient Spread (Ang^2) Time |<-- CONV
+--------------------------------------------------------------------+<-- CONV

------------------------------------------------------------------------------
Initial State
WF centre and spread 1 ( 2.200500, 0.000000, 0.000000 ) 0.71294917
WF centre and spread 2 ( 1.100250, -0.635230, 0.000000 ) 0.71294809
WF centre and spread 3 ( 1.100250, 0.635230, 0.000000 ) 0.71294809
WF centre and spread 4 ( 1.467000, -0.000000, 0.000000 ) 0.81286407
WF centre and spread 5 ( 2.933999, -0.000000, 0.000000 ) 0.81286543
Sum of centres and spreads ( 8.801998, -0.000000, 0.000000 ) 3.76457484

0 0.376E+01 0.0000000000 3.7645712185 0.04 <-- CONV
O_D= 0.0016044 O_OD= 0.7962785 O_TOT= 3.7645712 <-- SPRD

------------------------------------------------------------------------------
Final State
WF centre and spread 1 ( 2.200500, 0.000000, 0.000000 ) 0.71294917
WF centre and spread 2 ( 1.100250, -0.635230, 0.000000 ) 0.71294809
WF centre and spread 3 ( 1.100250, 0.635230, 0.000000 ) 0.71294809
WF centre and spread 4 ( 1.467000, -0.000000, 0.000000 ) 0.81286407
WF centre and spread 5 ( 2.933999, -0.000000, 0.000000 ) 0.81286543
Sum of centres and spreads ( 8.801998, -0.000000, 0.000000 ) 3.76457484

Spreads (Ang^2) Omega I = 2.966688302
================ Omega D = 0.001604421

Omega OD = 0.796278495
Final Spread (Ang^2) Omega Total = 3.764571218

------------------------------------------------------------------------------
Time for wannierise 0.004 (sec)

Output of a succesful run 

Three sp2 type-Wanniers
The manifold



How to plot the Wannier functions
WANNIER90 produces files with the name:

SystemLabel.manifold.X_0000Y.xsf that can be directly plotted with XCRYSDEN  
Once XCrySDen starts, click on 

File → Open structure (Select your xsf file)
Modify → Number of units drawn 2 (along x) 2 (along y) 1 (along z)

Tools → Data Grid 

Click on OK
Then, select: 

Degree of triCubic Spline: 3
Click on Render+/- isovalue

Select the desired isovalue (in this example 0.1)
Submit

graphene.manifold.first_00004.xsf

Lateral view Top view
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